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INFORMATIVA

Come prescritto dall'art. 1, comma 1, della legge 21 maggio 2004 n.128, 'autore avvisa di aver

assolto, per la seguente opera dell'ingegno, a tutti gli obblighi della legge 22 Aprile del 1941 n. 633,
sulla tutela del diritto d'autore.
Tutti 1 diritti di questa opera sono riservati. Ogni riproduzione ed ogni altra forma di diffusione al
pubblico dell'opera, o parte di essa, senza un'autorizzazione scritta dell'autore, rappresenta una
violazione della legge che tutela il diritto d'autore, in particolare non ne ¢ consentito un utilizzo per
trarne profitto.

La mancata osservanza della legge 22 Aprile del 1941 n. 633 ¢ perseguibile con la reclusione o
sanzione pecuniaria, come descritto al Titolo III, Capo III, Sezione II.

A norma dell'art. 70 ¢ comunque consentito, per scopi di critica o discussione, il riassunto e la
citazione, accompagnati dalla menzione del titolo dell'opera e dal nome dell'autore.

AVVERTENZE

I progetti presentati non hanno la certificazione CE, quindi non possono essere utilizzati per scopi
commerciali nella Comunita Economica Europea.

Chiunque decida di far uso delle nozioni riportate nella seguente opera o decida di realizzare 1 circuiti
proposti, ¢ tenuto pertanto a prestare la massima attenzione in osservanza alle normative in vigore sulla
sicurezza.

L'autore declina ogni responsabilita per eventuali danni causati a persone, animali o cose derivante
dall'utilizzo diretto o indiretto del materiale, dei dispositivi o del software presentati nella seguente
opera.

Si fa inoltre presente che quanto riportato viene fornito cosi com'e, a solo scopo didattico e formativo,
senza garanzia alcuna della sua correttezza.

L'autore ringrazia anticipatamente per la segnalazione di ogni errore.

Tutti i marchi citati in quest'opera sono dei rispettivi proprietari.
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Introduzione

I CAD Eagle rappresenta un'ottima scelta
per la realizzazione di schemi elettrici ¢ PCB
(Print Circuit Board). La casa produttrice
fornisce inoltre licenze gratuite per attivita no
profit, ponendo dei limiti che senza dubbio non
risultano dei vincoli reali per attivita
hobbystiche.

In questo Tutorial si spiegheranno le
principali funzioni del programma, focalizzando
l'attenzione su quelle che risultano piu utili per
I'hobbysta.

In particolare si illustrera come realizzare
uno schema elettrico, per poi passare al circuito
stampato. In ultimo si presenteranno alcuni
aspetti per modificare le librerie in modo da
adattarle ai propri scopi.

Installazione ed esecuzione del program-
ma

Eagle ¢ un CAD per la realizzazione di
schemi elettrici e circuiti stampati. E' possibile
scaricarlo dal sito della Cadsoft presente in
inglese all'indirizzo URL
http://www.cadsoftusa.com/ o in tedesco
all'indirizzo http://www.cadsoft.de .

A questi indirizzi alla sezione Programmi del
menu  Download' ¢ possibile scaricare il
programma Eagle.

Questo ¢ presente in lingua inglese e tedesca, sia
per il sistema operativo Windows che Linux.
Tra le varie versioni, quella a cui si fara
riferimento ¢ relativa al file eagle-win-eng-
4.16.exe.

Questo programma ¢ il file di setup che
permette di installare il programma.

Dopo l'installazione ¢ possibile eseguire il
programma.

Alla prima esecuzione apparira la finestra di
dialogo riportata in Figura 1.

Per mezzo di questa ¢ possibile abilitare la
versione gratuita utilizzabile per scopi non di
lucro.

Tale versione ¢ praticamente identica alla
versione con licenza escluse le seguenti
limitazioni:

' Da tale sezione & anche possibile scaricare altre

componenti che possono risultare utili per Eagle. Sono
per esempio presenti le librerie create dagli utenti
Eagle e Tutorial vari.

1. Le dimensioni del PCB possono essere
di 100x80mm.

2. E possibile realizzare un PCB con un
massimo di due facce (due layers).

3. L'editor di schemi elettrici permette di
realizzare schemi ad un solo foglio
elettronico.

Sono presenti anche limitazioni riguardo
l'assistenza tecnica, possibile solo via email o
tramite il loro Forum.

Tali limitazioni non sono molto restrittive e
permettono la realizzazione di gran parte dei
circuiti stampati di cui necessita I'hobbysta.

Nel caso si volesse utilizzare tale versione
per scopi di lucro € necessario registrarla; il
costo della licenza ¢ davvero irrisorio. Per scopi
non di lucro e con limitazioni inferiori, ¢
presente un'altra licenza con costi moderati.

B EAGLE Product Registration E]

EAGLE needs to inskall a license file on wour computer in
order bo wark,

Select Use license disk if vou have a personalized EAGLE
license disk.
Select Run as Freeware to run EAGLE as Freeware,

Use license disk ] |§Run as Freeware§| [ Cancel

Figura 1: Finestra di dialogo alla prima esecuzione del
programma

Una volta selezionata l'opzione Run as
Freeware apparira il Pannello di Controllo
riportato in  Figura 2.

Questa finestra di controllo sara la prima
finestra che apparira a partire dalla seconda
esecuzione del programma.

Per mezzo di questa finestra ¢ possibile

creare nuovi schemi elettrici, circuiti stampati e
file di libreria o aprirne di gia fatti.
Per mezzo dei vari menu ¢ possibile impostare
alcune delle caratteristiche principali del
programma stesso in modo da adeguarlo alle
esigenze dell'utente.
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Control Panel - EAGLE 4.16 Light g@@

Flle Yiew Options Window Help

Nar:ne Description EAGLE

LIS i DTS

Design Rules Design Rules Easily &pplicable Graphical Layout Editor
User Language Programs User Language Pragrams

Scripts Script Files Wersion 4.16 for Windows

CAM Jobs CéAM Processor Jobs

Projects Project Folder Light Edition

Comyrigin (<) 19852005 CadlSch
Al pigs v werldhwicke

Single User License #52191E841E-LSR-wLM-1EL
FOR EDUCATIONAL USE ONLY!

Reagistered to:

Freeware license far "non-profit
and ewaluation purposes. See the
file "freeware.key'' or the URL
e, cadsoft dedfreevare him'

Figura 2: Pannello di controllo di Eagle

Realizzazione di uno schema elettrico

Per spiegare le varie funzioni di cui si
parlera, si iniziera direttamente con un
esempio’.

Per la realizzazione di uno schema elettrico
bisogna aprire la relativa finestra dell'editor.
Questa viene selezionata dal menu File > New >
Schematic.

La finestra dell'editor che comparira sara uguale
a quella riportata’ in Figura 4.

E% 1 Schematic - C:\Programmi\EAGLE-4.16\untitled.sch - EAGLE 4.16 Light

File Edi Draw View Todls Lbrary Options Window Help
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Figura 3: Finestra per la realizzazione degli schemi
elettrici

2 Per ulteriori informazioni tecniche si faccia
riferimento al progetto “Alimentatori di tensione
stabilizzati 5V e 12V, 1A”.

3

L'aspetto potra cambiare leggermente al cambiare del
sistema operativo.

Come esempio provvederemo a realizzare un
semplice alimentatore stabilizzato da 1A, 5V,
come quello riportato in Figura 4
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Figura 4: Schema elettrico da realizzare

Vediamo come inserire 1 4 diodi del
raddrizzatore.
Premendo il tasto

ponte

&

presente nella barra dei comandi sulla colonna
sinistra della finestra dell'Editor di Figura 3,
apparira la finestra della libreria dei componenti
presenti, come riportato in Figura 5.

=/ ADD X
Name Description -~
Tinch 19-Inch Slot Eurocards
s CHOS Logic Devices, 4000 Seres
EaEy Alux Series Deviees
48m CMOS Logic Devices, 4500 Series

T4aclogic
Tdttl-din
Tduweu
Twwus

6l

altera
am23fhernory
amdmach
analogdevices

TTL Logic Devices. 744CT Txx and 7
TTL Devices with DIN Symbols

TTL Devices, 74w Series with Europ
TTL Devices, 74xx Series with LIS 8
5 Series Devices

Altera Progiammable Logic Devices
Advanced Micro Devices Flash Mem
AMD MACH4/MACHS Family [Vantis
Analog Devices Components

atrnel AR Devices

battery Lithium Batteries and NC Accus v
< >
Search Smds Deseription Preview

0K J[ Dep ][ Concel

Figura 5: Finestra di dialogo della libreria

Posizionandosi sul tasto

&

apparira la scritta “Add” che rappresenta la
funzione del tasto. Per ogni tasto apparira una
funzione differente. Scrivendo tale comando*
nella barra dei comandi e premendo invio, si
otterra lo stesso effetto della pressione del
pulsante. In Figura 6 ¢ possibile osservare la
barra dei comandi.

4 Non c'¢ differenza tra maiuscole e minuscole.
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8 & Q. a &«

Figura 6: Casella di testo dei comandi con il comando
""Add" inserito

E' possibile osservare che la libreria ¢ divisa

in molte librerie interne. Qualora non si conosca
la specifica libreria interna dove andare a
cercare, la ricerca pud essere non poco
fastidiosa.
Conoscendo perd il nome del componente ¢
possibile evitare ogni problema. In particolare
siamo interessati al diodo 1N4004. Per
effettuare la ricerca si scrive il nome del
componente sulla riga di ricerca e si preme
nvio.

Alcune volte possono essere presenti piu
componenti con nomi simili. Per evitare che la
ricerca fallisca ¢ bene mettere un asterisco alla
fine del nome. L'asterisco, come per il sistema
operativo DOS, significa qualunque carattere.
Dunque per individuare il nostro diodo ¢ anche
sufficiente scrivere 1n40*. Il motore di ricerca
visualizzera tutti i nomi che iniziano per 1n40
(nel nostro caso solo I'IN4004).

E' possibile vedere, come riportato in
Figura 7, che nella finestra della libreria,
compare il simbolo del componente e le
piazzole che verranno utilizzate nel PCB.

Una volta che ¢ apparso il componente nella
lista, selezionarlo e premere il tasto OK.

B ADD @
Name Desciption
=) dinde Diodss
4004 DIODE
=NAME >NAME
B VALUE SVALUE
DIODE ~
general purpose rectlfier.
< 5| | Package: D04110
Search Smds Description Ereview DIODE
nd00s v v
o [ bee | [ Coneel

Figura 7: Componente selezionato con relativo
simbolo e piazzole

Per molti componenti sono presenti piu
opzioni per le piazzole da utilizzare, in modo da

adeguarsi alle varie esigenze del progettista,
senza alcuna modifica.

Premuto OK, la finestra della libreria si
chiudera e sul mouse comparira il simbolo del
componente precedentemente selezionato. Con
un click del tasto sinistro del mouse, ¢ possibile
posizionare il componente. Dopo aver fissato il
primo diodo, sulla freccia del mouse sara
presente ancora il simbolo del diodo. Questo
permettera di inserire gli altri diodi come
riportato in Figura 4, la posizione ¢
naturalmente solo indicativa.

Per inserire 1 condensatori da 0.1uF bisogna
riaprire la libreria precedente, che sara ancora
posizionata sul risultato precedente.
Cancellando il nome 1n4004 e premendo invio,
¢ possibile far comparire tutte le librerie.

Per la ricerca delle capacita e dei resistori ¢
meglio sapere la libreria dove cercare, visto che
scrivendo solo C non portera a nulla.

La libreria di nostro interesse ¢ rcl, quando
viene selezionata, come riportato in Figura 8,
compaiono altre librerie interne.

Name Descriptior

# plorte PTCandMN

= Resistors, [
w CEU CAPACITO
& CTRIMM Trimm cap:
w CUS CAPACITO
& CFOLEU POLARIZE
& CPOLUS POLARIZE
® % % CAPACIT
@ o ¥ CAPACIT
® EL- BIPOLAR £
 LEU INDUCTOF
 LUS INDUCTOF
 AEU_ RESISTOF
& A-TRIMM Trmresis || Resistors. Capacitors, Inductors ~
& RUS_ RESISTOF || Based on the previous libraries:

& rectifier Rectiiers

= relay Relave ¥ - vl

< > + canlbr

Search Smds Description Preview * capfelbr v

v\« >
ok [ oo | [ Concel

Figura 8: Libreria rcl con librerie interne

Per i condensatori sono solito usare C-EU
(capacita europea) mentre per le resistenze uso
R-US  (resistenze americane) in modo da
rispettare gli standard grafici internazionali.

Per la capacita da 0.1uF selezionare quello
riportato in Figura 9, ovvero CEU050-024X044.

Selezionato il componente, premere invio e
posizionarlo come in Figura 4. Per le capacita
elettrolitiche, scegliere la libreria delle capacita
polarizzate (anche in questo caso sono solito
usare l'europea) CPOL-EU. Tra la libreria puo
andare bene il condensatore con diametro da
16mm per C3 e da 6mm per C4.

Per 1 16mm scegliere CPOL-EUE7.15-16
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mentre per 1 6mm scegliere CPOL-EUES-6.
Dopo aver selezionato il componente premere
invio e posizionarne due come riportato in
Figura 4. Si esegua cid per ogni condensatore.

Name Desciption ~
= CEU CAPACITOR. European syml
CEUDZE024<044 25024044
CEUDZ5-0254050 CO250254050
C-EU025-030<050 C025-030K050
CEUDZS-0404050 COZ5-MOKD50
CEUD25-060<050 CO25050K050
CEUDZ5-060K050 CO25-050K050
CEUD25_05IIZSK075 C025_D50-025K075
CEUDZE_D50ITER075 C025_060-036075
CEUDZ5_OB0MER075 C025_D50-046075
CEU025_0B0OSEX075 C025_D50055K075
CEU 044 COS0-024044
CEUDBO0Z5075 COB0075X075
CEUDS0030K075 COB0-030K078
CEUDS0033075 COB0-0354078
CEUOSO04075 COSO-0454075 Package: COSD024-D44
CEUDB0060075 COB0-050K075 ~| caPACITOR
< >

Seach [7] Smds V) Descrplion 7] Freview

_|>NAME &
T>vaLue

CAPACITOR, European symbol

grid 5 mm, outline 2.4 x 4.4 mm

ok | oo |[ Cancel

Figura 9: Capacita da 0.1uF

Per la resistenza in serie al diodo LED, da %
di W ¢ possibile usare, dalla libreria R-US , il
resistore R-US 0207/7, come riportato in
Figura 4.

Per inserire il led, selezionare la libreria led ¢ la
libreria interna LED e selezionare il LEDSMM.
Posizionare poi il led come riportato in Figura 4.
Come integrato regolatore ¢ usato il 7805,
questo puo perd essere scambiato con altri della
stessa  serie, provvedendo a cambiare
opportunamente le tensioni dei condensatori e di
alimentazione, nonché la resistenza sul diodo
led.

Per trovare il componente, aprire la finestra
della librerie e scrivere 7805* nella riga di
ricerca.

Dalla libreria linear che comparira aprire la
libreria interna e selezionare il 7805T, ovvero
con package TO-220; inserire poi il componente
come riportato in Figura 4.

In ultimo, restano da inserire 1 due connettori
per l'ingresso e l'uscita. D1 questi ce ne sono a
dir poco tanti, tra quelli piu standard si puo
scegliere la libreria con-wago-500 e selezionare
il connettore W237-102 e posizionarlo come in
Figura 4.

Prima di procedere su come collegare 1 vari
componenti per mezzo dei fili e nodi vediamo
altri comandi che possono risultare comodi per
riposizionare ed eliminare 1 componenti.

Il comando Move

<5

permette di muovere il singolo componente.
Uso: abilitare il comando e poi selezionare il
componente che sara libero di muoversi come
nel momento del primo posizionamento.
Premendo il tasto destro del mouse si effettua la
rotazione di 90° del componente.

11 comando Mirror
B

permette di effettuare l'effetto specchio sul
componente. Questo risulta utile nel caso di
amplificatori operazionali o comunque ovunque
si voglia semplificare la rappresentazione
grafica dello schema elettrico.

Uso: abilitare il comando e selezionare il
componente sul quale applicare 1'effetto Mirror.

Il comando Group

permette di  selezionare un
componenti.

Uso: abilitare il comando e mantenendo
premuto il tasto sinistro creare il rettangolo che
contiene i componenti d'interesse. Una volta
selezionato il gruppo si possono applicare altri
comandi. In particolare abilitando poi il
comando Move e tenendo premuto il tasto

destro sul gruppo creato ¢ possibile muovere il
gruppo.

gruppo di

Il comando Delete

X

permette di cancellare un componente dallo
schema.

Uso: abilitare il comando e cliccare con il tasto
sinistro sul componente da cancellare.

Il comando Name

A

2

!

(=]
=

permette di rinominare ogni componente, il
simbolo del resistore ¢ solamente mnemonico.
Uso: abilitare il comando e selezionare il
componente da rinominare. Sulla finestra di
testo che si apre, inserire il nuovo nome del
componente e premere invio.
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Il comando Value

R
-—-
101

premette d'impostare il valore del componente.
Uso: abilitare il comando e selezionare il
componente d'interesse. Sulla finestra di testo
che si apre, inserire il valore del componente e
premere invio.

Il comando Smash
£

permette di spostare le etichette del nome e del
valore del singolo componente, permettendo di
riordinare lo schema.

Uso: abilitare il comando e selezionare con un
click del tasto sinistro del mouse il componente
d'interesse. Sulle etichette Name e Value del
componente appariranno due crocette. Per
mezzo del comando Move (da abilitare) e
cliccando sulle crocette ¢ possibile spostare le
etichette del componente.

Il comando Text

T

permette d'inserire dei testi all'interno dello
schema elettrico.

Uso: abilitare il comando, premere il tasto
sinistro del mouse sulla posizione dello schema
dove si vuole inserire il testo. Sulla finestra di
testo che si apre, inserire il testo d'interesse e
premere invio.

Vediamo ora i tasti relativi alla connessione
dei componenti.

Il comando Wire

/

permette di connettere i terminali dei wvari
componenti.

Uso: abilitare il comando, cliccare con il tasto
sinistro del mouse sul primo terminale e
spostarsi per raggiungere il secondo. Per fare le
curve premere nuovamente il tasto sinistro.
Giunti al secondo terminale  premere
nuovamente il tasto sinistro.

Per terminare la connessione premere il tasto
Esc della tastiera. Dopo la pressione del tasto

Esc il comando Wire rimane ancora attivo per
altre connessioni. Premendo ancora Esc o
cambiando comando, il comando Wire termina.
Il comando Move puo essere utilizzato anche
per spostare le linee.

Il comando Junction

permette di inserire un nodo all'incrocio di due
linee.
Uso: abilitare il comando e cliccare con il tasto
sinistro sui punti dove si vogliono inserire 1
nodi.

Per mezzo di questi due ultimi comandi ¢
possibile terminare lo schema iniziato e ottenere
quanto riportato in Figura 4. Lo schema elettrico
¢ ora terminato.

Ogni volta che si effettua un salvataggio Eagle
salva una copia di backup cambiando il nome
del file .sch in .s#n con n un numero intero.
Dunque in caso di errori si puo ripristinare un
vecchio lavoro.

Dal menu File c'¢ la funzione Export che
permette di salvare la lista dei componenti
presenti nello schema (partlist) o salvare lo
schema come immagine .bmp (bitmap) .

Realizzazione dello sbroglio

Dallo schema elettrico precedentemente
realizzato ¢ possibile passare facilmente alla
realizzazione del PCB semplicemente premendo
il pulsante Board, presente sulla Toolbar
orizzontale.

I
N

Premendo su tale pulsante compare la finestra di
lavoro di Figura 10.
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= 2 Board - E:\LAVORI\Tutorial\Eagle\Figure\SchemaAlimenatore. brd - EAGLE 4.1... [ |[8][5]
Eile Edit Draw Yew Iools Lbrary Options Window Help

H&SF T W B 208 - D 7

Figura 10: Finestra di lavoro per la realizzazione del
PCB

Il rettangolo bianco rappresenta la
dimensione massima del PCB, ovvero non ¢
possibile porre i componenti al di fuori di tale
rettangolo.

Come prima cosa ¢ bene eseguire il comando
Errors

@©

che permette di visualizzare eventuali errori
commessi dalla parte dello schema elettrico.
Tipici errori sono dimenticanze di nodi o linee
elettriche che si sovrappongono con i pin di altri
integrati. Un altro errore tipico puo essere la
mancanza delle alimentazioni implicite degli
integrati. Alcuni integrati infatti hanno nascosti i
pin Vcc e Gnd. Queste alimentazioni devono
essere collegate richiamandole dalla libreria dei
componenti. In particolare Vcc potrebbe essere
poi collegata all'alimentazione +5V.

I componenti dello schema sono inizialmente
esterni al rettangolo e possono essere posti al
suo interno per mezzo del comando Move.

Ogni volta che si muovono dei componenti ¢
bene rieseguire il comando Ratnest

=

che permette di riaggiornare i collegamenti tra i
componenti per mezzo della linea piu corta. In
questo modo ¢ possibile posizionare i
componenti nel modo ottimale ovvero evitando
d'incrociare il piu possibile le linee elettriche.
Questo semplifichera il lavoro dell'outorouter e

di ridurre le distanze tra le capacita di filtro e 1
componenti critici’.

In Figura 11 ¢ riportato il risultato dopo il primo
posizionamento.

= 2 Board - E:\LAVORNTulorial\Eagle\FigureSchemaAlimenatore.brd - EAGLE 4.1.... (= |[8]&]
Elle Edit Draw Yew Iools Lbrary Options Window Help

eH&E&E & W BEY QAQQ @ v~ $F 7

Angle0 v [pdwdt (EB|ED

§ a|poEnenn 0219 [l
i
(s3] 2%
E Y
e
£
x4
1L o

B2 B
T

Left-click ta select object bo move

Figura 11: Primo posizionamento dei componenti

Per mezzo del comando Move & possibile
muovere anche i confini del rettangolo bianco in
modo da ottenere quanto riportato in Figura 12.
E' possibile osservare che sono state riadattate le
posizioni di alcuni componenti, infatti,
ingrandendo la visione del rettangolo, si hanno
dei miglior riferimenti.

In particolare si ¢ fatto uso anche del comando
Hole

&

che permette di inserire dei fori sul circuito
stampato. Quando viene selezionato tale
comando, la Tool bar cambia di aspetto e
visualizza 1 parametri relativi al foro.

= 2 Board - E:\LAVORNTutorial\Eagle\Figure\SchemaAlimenatore.brd - EAGLE 4.1... [2 B[]
Fle Edit Draw ¥ew Tools Lbrary Options Window Help

FHESE 2 W 2% GQQQE8 o~ DE 7
e e
§ o 0.0635 mm [52. 3675 52 2605] |—\ -

Ratsnest: Airmires: 23

> In questo modo si riducono anche le radiazioni

elettromagnetiche da parte del circuito.
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Figura 12: Adattamento del rettangolo bianco

Il foro in questione ¢ stato impostato su
32mm. Le opzioni sulla Tool bar sono
visualizzate in mil, per visualizzarle in mm
bisogna andare sul menu View > Grid; in
Figura 13 ¢ riportata la finestra delle
impostazioni della griglia. Il cambiamento da
apportare ¢ da inch a mm.

= Grid x

Dizplay Style

(3 On (& Off (1 Dats () Lines
Multiple: |1
Al 0635 mm
I u]: ] [ Default l l Last l [ Cancel ]

Figura 13: Finestra delle impostazioni della griglia

Posizionati i componenti si pud procedere
alla realizzazione del PCB.
Per mezzo del comando DRC

<

¢ possibile impostare i parametri principali che
dovranno essere soddisfatti dall'autorouter nel
momento in cui realizzera le piste del PCB.

Per [l'hobbysta non sara necessaria la
comprensione di tutti i1 parametri. In particolare
dalla finestra File ¢ possibile salvare le
impostazioni delle altre finestre su di un file. In
questo modo potranno essere richiamate di
Default senza dover impostare ogni volta i
parametri.

= |DRC (default) 3]
File | Layers | Clearance | Distance | Sizes | Resting | Shapes || Supply | Masks | Misc
EAGLE Design Rules

The default Design Fules have been set to caver a wide range of applications, Your paticular design may have different requirements,
50 please make the necessary adiustments and save your customized design 1ules under & new name.

Check | [ select [ appy | [ Cancel |

Figura 14: Finestra di dialogo del comando DRC

Dalla finestra Clearance ¢& possibile

impostare le varie distanze minime tra le piste,
pad e via in varie combinazioni. Uno spazio di
0.5mm ¢ in generale sufficiente per
realizzazioni hobbystiche.
In Figura 15 sono riportate le impostazioni
scelte, in particolare 1'immagine nel riquadro
nero cambia a seconda del parametro che si
imposta. In questo modo ¢ possibile
comprendere a cosa fa riferimento il parametro
che si sta impostando.

= |DRC (default) 3
Fie | Laers | Clearance | Distance | Sizes | Resting | Shapes | Supply | Masks | Misc
Different Signals
wire
wire [0.5mm Pad
Pad |0.5mm 0.5mm Wia
Via [05mm 0.5mm 0 5mn|
Same Signals
Smd Pad Via
Srnd [amil el Bl
Minimum Clearance between objects in signal layers.
The Same Signals check between Smdand bia daes nat apply to Miva Vios
Setting the values for the Same Signals checks to 0 disables the respective check
Check | [ Select | [ Apoly | [ Cancel

Figura 15: Finestra Clearance

Un ultimo parametro da impostare ¢ nella
finestra Size di Figura 16. In particolare ¢
necessario impostare la dimensione delle piste
utilizzate dall'autorouter. Nel nostro caso visto
che le correnti saranno di 1A ¢ bene porre una
dimensione di 1mm. In generale nel caso di
circuiti hobbystici ¢ bene non scendere sotto il
mezzo millimetro per evitare difficolta
costruttive del PCB.
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= DRC (default) ®

File | Layers | Cleamance | Distance | Sizes | Resting | Shapes | Supply | Masks | Misc

Minmumwidth [ Tmn
Minimum Drill 0.5mm
Min Micraia  [398mm
Min. Bind Via Ratio 0.5

e

Minimum Sizes of abijects in signal layers and of dil holes.

Minimum Width and Minimum Drill may be owerwiiten by larger values inthe Ve cissses far specific signals

Min. Micra Via applies to &indvias that are exactly one layer desp. Typical values are in the rangs 50..100 micran. & value larger
thar Minimum Drill [=.g. the default value of 3.99mm) means there are no micra viss.

Min. Blind Via Ratio defines the minimum dril diameter o'a blind via must have if it goes through a laper of thickness £ Board
manufacturers usually give this “aspect ratio” in the form 1: 0. 8. where 0. & would be the value that has to be entered here,

Check H Select | [ Appb ][ Concel

Figura 16: Finestra Size

Una volta effettuate le impostazioni ¢
possibile premere il tasto OK. Tra i vari tasti €
presente anche il tasto Check. Questo permette
di controllare se il PCB attuale verifica le
impostazioni dell'utente.

Periodicamente, quando si effettuano delle
modifiche manuale ¢ bene rifare dei controlli.
In particolare ¢ presente anche il comando

@

che permette dei controlli anche senza aprire la
finestra del comando DRC®.

Terminate le impostazioni ¢ possibile passare
alla realizzazione del PCB per mezzo
dell'autorouter.

Si fa subito presente che per applicazioni
delicate 1'autorouter non ¢ in generale idoneo.
Per le parti piu delicate ¢ infatti necessario
provvedere alla realizzazione manuale, per poi
terminare con l'autorouter.

Il comando Auto

H

permette di avviare la finestra di dialogo
riportata in Figura 17. Anche in questo caso non
sara necessario sapere tutto. La prima finestra

General ¢ generalmente piu che sufficiente per
8 Quando si corregge un errore segnalato dal comando
Erc questo sara sempre segnalato da una nuova
esecuzione del comando Erc. Per essere certi che
l'errore ¢ andato via bisogna fare il controllo Check
dalla finestra del comando DRC.

applicazioni hobbystiche.

= | Autorouter Setup @

General Busses | Route Optimize1 Optimize2 | Optimize3 Optimize4
Preferred Directions Flouting Giid |05 [T
1Top [N » ‘ia Shape | Round ha
1E Battom | * v
oK l [ Select ] [ Cancel ]

Figura 17: Finestra di dialogo del comando Auto

Come prima cosa bisogna abilitare o meno il
livello superiore e inferiore. Nel nostro caso
l'applicazione sara monofaccia, dunque il livello
Top ¢ posto su N/A, ovvero not available. Le
altre opzioni relative al frame Preferred
Direction, sono relative alla direzione delle
piste, nel nostro caso una vale l'altra ma
cambiera leggermente 1'estetica.

Altro parametro importante da impostare ¢
Routing Grid, ovvero la dimensione della griglia
di sbroglio. Piu la griglia ¢ piccola e maggiori
sono le possibilita che il circuito venga
sbrogliato.

Con griglie fine sara perd necessario piu
tempo per lo sbroglio automatico e maggior
memoria. In particolare la dimensione della
griglia viene a dipendere anche dalle dimensioni
che si sono poste nella finestra del comando
DRC. Questo vuol dire che se si impostano piste
da 2mm e spazi di Clarence di 1mm, una griglia
di 0.1 ¢ in generale uno spreco. Nel nostro caso
una griglia di 0.5mm sara senz'altro piu che
sufficiente.

Impostati questi parametri ¢ possibile avviare
la procedura di sbroglio automatico premendo
OK.

Quello che si ottiene ¢ riportato in Figura 18.
Si fa notare che ¢ stato aggiunto il testo
Copyright 2006 Mauro Laurenti che come ¢
possibile osservare ¢ scritto all'incontrario.
Questo non ¢ un problema poiché stampando il
circuito sara scritto al dritto. Qualora doveste
leggere tale scritta al contrario anche sul circuito
stampato avete fatto l'errore piu fastidioso da
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accettare...avete stampato il circuito al contrario.

‘= | 2 Board - E2ALAVORNTutorial\Eagle\Figure\SchemaAlimenatore.brd - E... @@
File Edit Draw Miew Tools Lbrary Options Window Help

EHSF T W 2% Q8@ -~ BF 2

O pngle 270 v |af e HB B

i ® 00635 rarn (76,0730 51.3080] r

~ i

@B ¢0BEON AN
M BRI AN

Left-click to select object to move

Figura 18: Risultato dello sbroglio automatico

Qualora le piste non siano di gradimento o
'autorouter non abbia sbrogliato tutte le linee ¢
possibile modificare la singola linea per mezzo
dei seguenti comandi

-
7 A
TS

Un semplice uso da parte del lettore varra piu di
mille parole.

In ultimo se si € giunti a realizzare tale
sbroglio si € certamente interessati a realizzare il
PCB, sara dunque necessaria una stampa.

Per mezzo della stampante verra stampato
tutto quello che viene visualizzato sullo
schermo. Per realizzare un PCB con tecniche
artigianali, bisogna rimuovere 1 componenti
poiché la loro stampa sarebbe come una
moltitudine di cortocircuiti. Quello che bisogna
fare ¢ visualizzare solo le piste ovvero togliere
la stampa dei componenti.

Per fare cio bisogna usare il comando Display

e disabilitare tPlace. In Figura 18 era stato gia
disabilitato tValue, il quale visualizza il nome

dei componenti o il valore degli stessi.
Disabilitando tPlace, si otterra quanto

visualizzato in Figura 19.

| 2 Board - EALAVORI\Tutorial\Eagle\Figure\Schemahlimenatore.brd - EAGLE 4.16 L... [ |[B][]
File Edit Draw View Toaols Library Options ‘Window Help

EHSE & W 2w QQQQAH |« P F| 7
ie 0.0635 mm [24. 7725 50.4825) ’7

=
N

P EOBON A
M B

Figura 19: Visualizzazione delle sole piste del circuito
stampato

Dopo quest'ultima impostazione si € pronti a
stampare il circuito stampato sui vari supporti
che si intende utilizzare.

La finestra di stampa, riportata in Figura 20,
¢ richiamabile dal menu File > Print. E bene
impostare la stampa in bianco e nero ovvero
Black, in modo da ottenere il miglior contrasto
chiaro scuro.

Dopo questa operazione avviare la stampa e
parte del gioco ¢ fatto.

Un utile strumento per realizzare immagini
bitmap del solo PCB, da utilizzare all'interno di
documenti di testo, ¢ la funzione Export del
menu File.
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= Print E|

Frinter: Automatico HP Laserlet 1200 Series PCL su FABRIZI0
Faper: A4 (2102297 mm, 8.26x11.7 inches]
Orientation: portrait
Style
[] Mirrar
[] Rotate Scale factor: 1
[] Upside dawn
EBlack Fage limit: ]
[] Salid
| Ok | [ Printer. . ] [ Page. .. ] [ Cancel ]

Figura 20: Finestra di stampa

Modifica dei Package di Libreria

I package che sono presenti all'interno della
libreria di Eagle sono particolarmente adatti nel
caso in cui si faccia uso di circuiti con almeno
due faccie e con fori metallizzati. Questo
significa che per gli hobbysti possono risultare
inadatti.

Infatti il loro diametro ¢ spesso insufficiente per
le punte da trapano da 1mm che ['hobbysta usa.

In particolare per I'esempio dello schema e
PCB riportato sopra, si ¢ fatto uso di una libreria
gia modificata’. Per fare questo si deve
procedere come segue. Se si ha pazienza di
modificare le intere librerie quanto verra detto
tra poco potra essere saltato.

Quando si inserisce un nuovo componente
dall'editor dello schema elettrico, ovvero si
cerca un componente all'interno della libreria,
come per esempio in Figura 9, nella seconda
colonna del componente selezionato o nella
casella di testo nell'angolo in basso a destra ¢
riportato il nome del package. Per poter
modificare tale package bisogna per prima cosa
prendere nota del suo nome.

E' bene procedere in maniera analoga anche
per gli altri componenti che bisogna modificare.
In particolare i1 package che si modificano
avranno influenza solo dagli schemi elettrici che
si creeranno o cambieranno dopo la modifica.

7 Qualora si faccia uso della tecnica qui descritta ¢ bene

fare una copia della libreria originale e modificare la
copia, nonché salvarla in un altro percorso. Se si
dovessero installare nuove versioni di Eagle il lavoro
andrebbe altrimenti perduto. La cosa migliore sarebbe
quella di creare una libreria personale exnovo.

Dunque lo schema precedentemente realizzato
deve essere rifatto!

Una volta scritti 1 vari packages che si
vogliono modificare, chiudere la finestra
dell'editor degli schemi elettrici.

Per l'esempio d'interesse i packages che ¢ bene
modificare sono 1 seguenti :

C050-024x044
207/7
LED5SMM
D041-10

Per iniziare la modifica, dal Control Pannel,
andare al menu File > Open > Library... e aprire
la libreria, ovvero il file, rcl.lib. In Figura 21 ¢
riportata la finestra di modifica delle librerie.

®I 1 Library - C:\Programmi\EAGLE-4.16\Ibr\rcIMONO. Ibr, () - EAGLE 4.16 Light (M(=1E3]
Fle Edit Draw Wew LUbrary Options Window Help

BRAAE| > > D F|?
% [oosinchines e | || -
Eud

=EHE 3BH L =2

Figura 21: Finestra di dialogo delle librerie

Da questa finestra andare al menu Library >
Package ¢ selezionare il package d'interesse.
Nell'esempio si considerera il package della
resistenza 207/7.

In Figura 23 ¢ riportata la finestra per la
modifica delle librerie con relativo package da
modificare.

Per mezzo del comando Display ¢ bene
disabilitare tPlace che rappresenta il disegno del
componente. In questo modo sara piu facile
modificare le piazzole del componente. Per
disabilitare il livello tPlace basta cliccare con il
tasto sinistro sul numero 21, come riportato in
Figura 22.
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%l Display

Lapers:

MNr MHame ”~

Urrouted

Dimengion

tPlace

bPlace

tOriginz

bOriging w

][ Change ][ Del ]

[ HNew

[ Al ][ Mone ]

[ 0K l [ Cancel ]

Figura 22: Finestra che si attiva con il comando
Display

©OEON e XRIT
1RO

Figura 23: Finestra di modifica librerie con package
207/7

Dopo la conferma con OK, si otterra la
Figura 24 con le sole piazzole.
Per modificare il diametro delle piazzole
bisogna attivare il comando Change

y?

questo permette di cambiare il diametro delle
piazzole, del foro e la forma stessa. Questo
comando risulta utile anche per cambiare i
parametri di altri oggetti.

8l 1 Library - C:\Programmi\EAGLE-4.16\lbr\rcIMONO. Ibr (0207/7. pac) - EAGLE 4.16 Light
Ele Edt
H& T8>

P
aeaa@ o~ TE ?
5 wlomne s [

©@BEO\ W= X

Figura 24: Finestra del package 207/7 con tPlace
disattivo

Abilitando il comando Change comparira il
menu di pop up riportato in Figura 25 nel quale
andra selezionata la voce Diameter e poi
selezionato il diametro d'interesse che nel nostro
caso ¢ stato posto a 0.076mil (non millimetri).

Sl 1/ Library, - C;\Programmi\EAGLE-4.16\brArcIMONO, Ibr. (0207/7.pac) - EAGLE 4.16 Light
windon Help

tlaaQae o $E 7

0012
0.016
0.024
0052

Figura 25: Menu di pop up del comando Change

Impostato il nuovo diametro, basta cliccare
con il tasto sinistro del mouse sulle piazzole
d'interesse, al fine di modificarle. Modificando
la voce Drill e Shape ¢ possibile cambiare
anche la dimensione del foro e la forma della
piazzola.

Dopo la modifica delle piazzole riabilitare il
livello tPlace e salvare la libreria con il
comando Save. Ripetendo questa operazione
con i package d'interesse il gioco ¢ fatto. Si fa
presente che la procedura ora descritta puo
essere svolta anche in altro modo.
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Creazione del PCB 3D, Eagle3D

Una volta giunti a questo punto, anche se si
¢ imparato a realizzare il PCB per mezzo del
CAD Eagle non si ha ancora una visione reale di
come sara il circuito stesso. La visione 2D
offerta da Eagle ¢ sicuramente un buon punto di
partenza, ma perché accontentarsi di una vista
2D quando si pud avere una visione 3D! In
questo paragrafo si descrivera un tool esterno ad
Eagle, ma che utilizza Eagle per mezzo del suo
linguaggio ULP?, ...iniziamo.
Il programma di cui si fara uso ¢ Eagle3D’,
realizzato dal tedesco Matthias Waifer. Il
programma pud essere scaricato dalla pagina
web:

http://www.matwei.de/

dal menu Eagle3D. Oltre al programma stesso, ¢
bene scaricare subito il file zip da 38MB che
contiene le immagini 3D dei componenti
supportati da Eagle3D!’. Fatto questo bisogna
scaricare il programma POV-Ray dal sito:

http://www.povray.org/

Questo programma verra utilizzato per
realizzare il render del file .pov generato da
Eagle3D e ottenere 1'immagine 3D. Ottenuti tutti
1 programmi, installare il tutto e “unzippare” il
file zip da 38MB salvandolo in un percorso
noto.

A questo punto avviare Eagle (non Eagle 3D)
ed aprire la videata board'. Sulla barra dei
comandi scrivere run € premere invio, come
mostrato in Figura 26.

8 I file .ulp rappresentano file con programmi scritti in

ULP (User Language Program) per mezzo dei quali ¢
possibile estendere le funzionalita di Eagle. Eagle3D
ne rappresenta un esempio.

Da questo punto in poi si fara uso di Eagle 5 ¢ non
Eagle 4. Ciononostante Eagle3D lavora anche con
Eagle 4.

Questa non €' la libreria attuale ma solo una versione
grafica della stessa.

Eagle3D non funzionera se si lavora dalla schermata
Schematic.

0.635 mm (67,310 35.56

Figura 26: Esecuzione del comando run

All'esecuzione del comando, Eagle mostrera
una finestra di apertura file, per mezzo della
quale ¢ possibile aprire il file .ulp d'interesse
come riportato in Figura 27. da questa finestra
selezionare il file 3d41.ulp

Run @@
Cerzaijn ‘_) up j ¥ E-

5 bom.ulp
e cam2dxzF.ulp
Dacumenti camzimage.ulp
recenti camZprink.ulp

@ emd-showzoom,ulp
@ cmd-snap-board.ulp
@ cmd-snappads. ulp
copy-silk-screen.ulp
@ copy-text-as-wire,ulp

Desktop

Documenti

T% change-pad-in-lbr,ulp
clear-laver-inbr.ulp

cmd-change-brd-width.ulp
cmd-change-dass.ulp
cmd-change-swap-layer.ulp
cmd-draw,ulp

copy-wire-to-any-layer.ulp
@ count.ulp
@ del-devices,ulp
@ del-emply-devices.ulp
@ del-pack-sym.ulp

cmd-net-list2sch.ulp @ dif40.ulp
) cmd-netscript2sch.ulp @ dose-pro.ulp
,_‘-‘g cmd-place-restrict-name-value.ulp @ drill-aid . ulp
F\is‘aﬁe el cmd-rename-in-lbr .ulp @ drillcfg.ulp
computer cmd-renumber, ulp @ drillegend. ulp
« A < >
2
Rizorse direte  Nome file: | ﬂ Apri |
Tipo file: |User Language Programs [ ulp) j Annulla

Figura 27: Selezione file 3d41.ulp

Il file .ulp di nostro interesse non ¢ pero tra
questi (usando la versione Eagle 5), ma dentro
la cartella d'installazione di  Eagle3D.
Nell'istallazione di default effettuata sul mio PC
il percorso ¢:

C:/Programmi/Eagle
All'interno della directory Eagle ¢ presente la

directory /ulp/Eagle3D/ come mostrato in
Figura 28.
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Cerca i |l'f}EagIaBD j . ok @
=hdac
; IChexamples
Dn:ume_mti Cipovray
recenti 3d4D.qu
¢
3dfun:4D.qu
Desktop 3dfunc41.ulp
Documenti
Risorse del
compLter
Risorse direte  Mome file: |3d41 ulp ﬂ Apri |
Tipo file: |User Language Programs [ ulp) j Annulla

Figura 28: Selezione file 3D41

All'apertura del file ulp, verra aperta la
finestra di Eagle3D, come riportato in Figura
29.

& | Eaple: Eagle3D (v1.05) Parametri di Input

Generale | Scheda | camera | Luce 142 | Luce3+d | varie | Colon

Render
Companenti Paligoni

Collegamenti Fori (modo Real)
Piazzole SMD [1 Fari (moda Fast)

D Componenti sconosciuki

[1 Modelli assegnati dal'Ukente Scheda
Pins corti [1 scheda rettangolare
Serigrafia SFonda Immagine

[[1 Asseqna da file brdname. mpd [1 Taglia Piedini

File: di destinazione

‘C:;’Documents and Settings/MaurofDesktopiProvalSchemadlimentatore, pov |

[ Sfoglia ] [ Imposta il percorso del file .BRD ]

SprachefLanguage

‘Itahan v
I Crea POY-File ed esci ] [ Crea POV-File ] [ annullafEsci

Figura 29: Finestra Eagle3D

I valori di default sono tali per cui si
otterranno dei buoni risultati senza dover
toccare nulla. Unica cosa da selezionare, sara il
percorso di destinazione dove verra salvato il
file .pov che successivamente utilizzeremo per
creare la nostra immagine 3D.

£ | Eagle: Eagle3D (v1.05) Parametri di Input

Generals ‘ Scheda ‘ Camera | Luce 1+2 | Luce 3+4 | Warie | Color

Dimensioni

PCB- Spessare scheda(in mm) ‘ 1.5 ‘
PCB- Spessare rame (in mrm) ‘D‘DSE ‘
Diametra Fori {mnm) ‘2 ‘
Salder Mask sui ¥IA fino a {mm) ‘IJ ‘

|

angolo di rotazione della scheda ¥, v,2 ‘U E | |El k5 | |El ke

Y

Crea POV-File ed esci I [ Crea POY-File ] [ AnnullafEsci

Figura 30: Tab Scheda

Nella spiegazione che segue non andrd in
merito ai dettagli ed impostazioni che ¢
possibile cambiare nei vari tab, lascio a voi
giocarci o documentarvi al sito ufficiale di
Eagle3D'. Ciononostante ¢ bene spendere due
parole sul tab Scheda. Per mezzo dei settaggi di
questo tab ¢ possibile ottenere la rotazione del
PCB (sui vari assi), cambiando dunque il mondo
con cui verra visualizzato. Per mezzo di questa
opzione ¢ possibile mettere pit 0 meno in
evidenza particolari componenti altrimenti
nascosti.

A questo punto non ci resta che premere il
pulsante in basso “Crea Pov-File ed Esci”. A
fine scrittura del file .pov verra visualizzata la
schermata di Figura 31.

% Eagle: 3d41.ulp X

File POWRay scritho con successo

Figura 31: Finestra a fine scrittura file

In questo semplice esempio non ci sono state

"2 Tra le altre funzioni di Eagle3D c'¢ anche quella di

realizzare dei video, ma questo esula dagli scopi di
questa breve documentazione.
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finestre intermedie prima del messaggio di All'esecuzione del comando si aprira il

Figura 31. Quando sono presenti dei led, si blocco note di Windows con il file .ini di POW-

aprira una finestra che chiedera il colore del led Ray. All'ultima riga bisognera impostare il

e se si vuole la trasparenza. Per gli IC verra percorso necessario a far riconoscere la libreria

chiesto se si vogliono gli zoccoletti e cosi via. di Eagle3D. La riga da aggiungere ¢:

Le varie domande poste sono molto semplici e

di buon senso. Library Path="C:\Programmi\Eagle\ulp\Eagle3
D\povray"

Una volta creato il file .pov bisogna aprire

POV-Ray precedentemente installato, ed aprire ovvero:

il file .pov creato da Eagle3D nel percorso da

voi scelto. Ad apertura file dovreste avere Library Path=

qualcosa di simile a Figura 32.
piu il percorso (incluso tra pedici)

Dal momento che questa ¢ la prima volta che si
esegue POV-Ray bisognera impostare alcune \Eagle\ulp\Eagle3D\povray
cose. Queste impostazioni non dovranno essere

rieseguite in futuro. la cui radice cambiera a seconda del percorso
che avete scelto per installare Eagle3D.
L g D ) e e T e Una volta aggiunta la riga del percorso, salvare
LbemgpeRawD 0D e chiudere la finestra del blocco note.
[B00%600, &4 0.3] v D Ppovwn P Scene ¥ hccessories P POV Site ¥ IRTC Ste
Messages | Schemaflimentatare pov . .
;;gjggggggg}g@gsgg:’,a;;z;:;ﬁ,xmm artabile 2.20-250, 1. dars/Seheneal mencarare. rd A questo punto ¢ tutto pronto per avere il nostro
pron file 3D. Ovviamente abbiamo impiegato un po'
i{git](ziin 11’;:22 THE shnu]d be used as .inc . . . . .
e fTe asTinErore) di tempo poiché ¢ stata la prima volta, ed ¢ stato
] T oo e necessario installare diversi programmi.

J/Nmber oF the color Tor SEE redisrors

//0=Green, 1="normal :tﬂur ,2=Elus 2=Brown

¥deciare global_res_cel =

J/5et to on T you want ta rem:ler ‘the PCE upside-down

e PR Sehna tne ::rr:izundmg axis (referring to pcb_upsidedown) Per ottenere l'immagine 3D premere il tasto Ini
dalla Tool bar riportata in Figura 34.

#declare pcb_rotdir
//3et the Tength
Fleclare pin-leng
obal_dion
ettt e ey
#declare global_sold

Figura 32: Apertura del file pov per mezzo di POV-Ray q@ @ @
Ini  Sel-Run Run

Dal Menu Tools, eseguire la voce “Edit
master POVRAY.INI”, come mostrato in Figura 34: esecuzione del comando Ini

Figura 33.
All'esecuzione del comando verra

visualizzata la finestra di Figura 35. L'unica

N GUI-Extensions  Help cosa che bisogna cambiare ¢ il formato,
Help On This Menu maggiore sara 12} risoluzione del formato scelto,
Re-lnad Tool Menu maggiore sara il tempo necessario per la sua

realizzazione.

Edit master POYRAY, INI

Edit PYEMGIME . IMI

Edit last rendered File
Edit last scene file

Wiew |ast rendered file
Wigw histogran image File
Edit resolution IMI File
Edit this menu.

Figura 33: Impostazione del file INI
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POV -Ray for Windows Render Settings rzl
Source file:

Path: |

Mame: | |

INI File:
Path: |C:\PF|DGF!AMMI\F’DVVF!AY FOR WINDOWwS W3 B\RENDERER

Mame: [QUICKRES INI | section:

[ Browse ] [ Drefault ] I Edit ] [ Clear ]

Command line options:

{ Render I ’ﬁelbuldun‘lﬁendar] ’ LCancel ] [ Help I

Figura 35: Settaggi pre-render

Sulla destra del formato ¢ possibile vedere
che ¢ presente AA. Ogni formato ha anche
l'opzione “No AA” per mezzo della quale
I'immagine ¢ ottenuta piu grossolana (ma in
minor tempo). Selezionata la risoluzione
dell'i'mmagine ¢ possibile procedere con la

pressione del pulsante “Render”.

La prima volta che si esegue il render ¢
possibile avere il messaggio di errore riportato
in Figura 36. E' possibile premere OK e il
programma continuera la sua esecuzione. Il
messaggio di errore non verra rivisualizzato ad
una seconda esecuzione del programma.

If0 Restriction Activated

@ If0 restriction prohibits read access ko 'CiiProgrammilEagletulp\Eagle3Dipovrayy’ for tools,inc’,

Press OK to grant temporary read fwrite permission in that directory {and its subdirectories).
Press CAMCEL to halt the render.

Press the HELP button to learn about If0 Restrickions,

oK ]l Annulla \[ ?

Figura 36: Errore di accesso file

Una volta premuto OK, apparira la nostra
finestra con il PCB 3D, linea dopo linea, come
riportato in Figura 37. Dopo tanto sforzo si ha la
delusione che alcuni componenti mancano!
Effettivamente non tutti i componenti di Eagle
sono collegati ad un componente 3D della
libreria di Eagle3D. Ciononostante la libreria di
Eagle3D ¢ molto vasta ed i componenti
mancanti sono spesso presenti, bastera creare il

link mancante®>.

Figura 37: PCB 3D

Per creare il link ¢ necessario sapere quali
sono i componenti da collegare. Per fare questo
bisognera andare sullo schema di Eagle e
cliccare sul comando d'informazione 1 sulla tool
bar laterale, come riportato in Figura 38.

[ ]
I
Figura 38: Comando d'informazione

Una volta selezionato il comando, cliccare
sui componenti dello schema per i quali non ¢
stato creato il componente 3D. In particolare il
resistore R3 e i condensatori C2, C5.

Cliccando sui componenti verra visualizzata la
schermata d'informazione di Figura

E' possibile vedere che il Package del
resistore ¢ il RTRIMT93XA. Ripetendo quanto
descritto per i due condensatori si ha che il
Package di C2 ¢ E5-6, mentre il package di C5 ¢
ES5-5. Per semplicita considereremo entrambi i
condensatori con diametro 6 mm.

A questo punto bisognera cercare i package 3D
dei componenti mancanti all'interno della
cartella precedentemente creata dal file zip da
38MB. Questa cartella contiene tutti i modelli di
esempio dei package supportati da Eagle3D.

" In questa guida non si descrive come creare un

componente 3D e sua descrizione in linguaggio pov.
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x)

B|Properties

Part
Mame R3
Position 5.4 2.2
Gate {R-TRIM)
Angle ] L
[T mirrar
Device R-TRIMMTI3XA (R-TRIMM)
Package RTRIMTS3%A
Libraty relMOM D
Yalue
[] smashed
Trirnn resistar
ik l [ Zancel l ’ Apply

Figura 39: In formazione del Package del trimmer

Per 1 nostri componenti 1 package da
utilizzare sono rispettivamente il trimmer
RES DIS TRIM 64Y e i condensatore
CAP DIS ELKO 2MM 5MM come riportato
in Figura 40 e 41. Si fa notare che 1 nomi dei
Package sono i nomi delle immagini stesse;
inoltre non necessariamente 1 componenti scelti
sono uguali al 100% con la serigrafia, il trimmer
¢ infatti a rotazione verticale. Qualora si volesse
una riproduzione perfetta sarebbe necessario
costruire il proprio componente, ma questo
esula dagli scopi di questa guida. Una volta
individuati 1 package dallo schema e 1 package
3D da utilizzare ¢ possibile continuare.

Figura 40: Package del Trimmer

Figura 41: Package del Condensatore elettrolitico

Per inserire 1 componenti mancanti ¢
necessario nuovamente rieseguire il comando
run per creare un nuovo file pov.

Una volta ottenuta la schermata di Eagle3D,
selezionare la voce “modelli assegnati
dall'utente, come riportato in Figura 42.

L'unica cosa che bisogna cambiare ¢ il
formato, maggiore sara la risoluzione del
formato scelto, maggiore sara il tempo
necessario per la sua realizzazione.

‘£ Eagle: Eagle3D) (v1.05) Parametri di Input

Genersle | Scheda | Camera | Luce 142 | Luce 3+4 | Varie | Colori

Render

Componenti
Callegamenti
Piazzole SMD

Poligoni
Fori imodo Reeal)
[ Fari (modo Fast)

ermponenti sconosciuly
Scheda

[] Scheda rettangolare
Setigrafia Sfondo Immagine
[] Taglia Piedini

odell assegnati dallUtente

s corti

[] assegna da File brdname.mpd

File di destinazione

C:/Dacuments and Settings/MaurofDeskbopfProvaSchemadlimentatare, pav

[ Sfoglia I [ Imposta il percorso del file \BRD

SprachefLanguage

Italian w

[ Crea POV-File ed esdi ] [ Crea POY-File l I AnnullafEsci

Figura 42: Impostazione “Modelli assegnati dall'utente”

La voce ‘“componenti sconosciuti” verra
automaticamente selezionata. A questo punto ¢
possibile procedere con la creazione del file
.pov. Quando Eagle3D trovera un componente
sconosciuto, chiedera cosa fare, come riportato
in Figura 43.
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= |Eagle: Assegna Componente

Hame: C2
Value: 47F

Package: ES-6

Eagle-Package POVRay-Macro Commenti (s}
0204/5 RES_DI5_0204_O54MM( Discrete Resistor 0,154 5,4MM Grid

02047 RES_DI5_0204_O75MM( Discrete Resistor 0,154 7,5MM Grid

az04y RES_DI5_0204_0Z5MM( Discrete Resistor 0,154 Yertical 100mil

020710 RES_DI5_0207_LOMM( Discrete Resistor 0,3 10MM Grid

0z07/12 RES_DI5_0207_12MM( Discrete Resistor 0,3 L2MM Grid

0207}15 RES_DI5_0207_{5MM{ Discrete Resistor 0,3/ 15MM Grid

2072V RES_DI5_0207_0Z5MMV( Discrete Resistor 0,25W Yertical 100m

0207/5% RES_DI5_0207_O5OMMYV( Discrete Resistor 0,25W Yertical 200

0207/7 RES_DIS_0207_O7SMM] Discrete Resistor 0,3% 7,5MM Grid

iz PH_2MM_1%2( 2mm pinheader

0309710 RES_DIS_0309_10MM{ Discrete Resistor 0,354 400mil

0309/12 RES_DIS_0309_12MM( Discrete Resistor 0,354 S00mil

0309y RES_DI5_0309_ZSMIV( Discrete Resistor 0,35W 100mil vertical

0P PH_ZMM_1%3( 2mm pinheader

0402 NOMACRO Do nat use!!1! spedal

0414715 RES_DI5_0414_1SMM( Discrete Resistor 0,5 600mi

0414y RES_DI5_0414_OSOMIV( Discrete Resistor 0,5 200mi vertical

sF PH_ZMM_1X5( 2mm pinheader

0603 NOMACRO Do not use!!1! spedal

0617117 RES_DI5_0617_17HMM{ Discrete Resistor 14 700mil

sL7fz2 RES_DI5_0617_22MM{ Discrete Resistor 14 900mil

6Ly RES_DI5_0617_OSOMMV( Discrete Resistor 14 200mil vertical

0805 NOMACRO Do not use! 11! spedal

oszzfze RES DI5 0922 Z2MM( Ciscrete Resistor 1.3 900mi hs
< I 3

| [ess J[ese |
[ Cerca package ][ Certa POVRay-macra ] Cerca conmento )|
I Mostra Immagine |
[ ok ][ Non assegnars modelo ] [ Escimodalta "assegnat dalutente” |

Figura 43: Finestra per impostare i componenti
sconosciuti.

I primo componente non trovato ¢ il
condensatore elettrolitico (package E5-6). Nella
casella di testo sopra il tasto “Cerca POVRay-
macro”,scrivere CAP_DIS ELKO 2MM_5MM
e premere il tasto “Cerca POVRay-macro”.

| CAP_DIS_ELKO_2MM_SMM |

[ Cerca POVRay-macro ]

Figura 44: Funzione cerca

Se il package verra trovato (noi sappiamo gia
che esiste) il package verra evidenziato tra la
lista dei package presenti. A questo punto
premere OK.

Questa operazione deve essere ripetuta per ogni
package sconosciuto. Qualora non si avesse
nessun package per il componente mancante
premere il pulsante “Non assegnare modello”.
Se cosi non si facesse verrebbe creato un link
errato tra i package. Questo creerebbe un errore
durante il render del file .pov.

Una volta assegnato 1l package ad ogni
componete, il file .pov verra nuovamente creato.

Se il vecchio file pov era rimasto aperto nella
finestra del POV-Ray, il programma chiedera se
aggiornare il file come riportato in Figura 45.
Premere “Yes, Relead” o chiedere il vecchio file

e aprire il nuovo

File Changed

File 'Schemadlimentatore poy' has changed on disk.,

This file was modified outside POWWIN, Should it be reloaded ?
(5ee the help file For more information about this feature and how ko control it )

‘Yes, Reload | [ Mo, Don't Reload ] [ Ignore All ] [ Help

Figura 45: Aggiornamento del file pov

Rieffetuare il render del file pov, ed il gioco
¢ fatto (Figura 46).

In realta il gioco pud risultare piuttosto
complicato, infatti se il package scelto dovesse
essere errato Eagle3D creera il link e poiché per
lui i1l package ¢ divenuto noto, non chiedera piu
di cambiarlo, dunque per quanto ne sappiamo
non ¢ lecito sbagliare.

In realta sbagliare ¢ lecito ed umano, dunque
ecco il rimedio a noi stessi!

Eagle3D crea i link all'interno del file
3dusrpack.dat  presente  nella  directory
\Eagle\ulp\Eagle3D\. E possibile aprire tale file
con POV-Ray stesso andando su Open e
selezionando “All Files (*.*)” come tipo file
della finestra Apri File.

@ 366,2

Figura 46: Nuova visione 3D

Il file dovrebbe somigliare al file di Figura
47. Ogni linea rappresenta un link tra il package
di Eagle e il modello 3D di Eagle3D. Da questo
si evince che in passato ho creato altri link.
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© POV-Ray - C:\Programmi\Eagle\ulp\Eagle3D\3dusrpac. dat
Fie Edt Seach Iot Egtor Insert Render Options Took GUiExtensions Help

[512x384,820.3] ¥ PPOVWN  Pscene @ Accessores PPOVSEe FIRTCSte

Messages | Schemadlimentatore.pov | dusrpac.det

>

Fie saved L0 | c1 s 4307PPS 0d00h 00m 415

Figura 47: Esempio di file 3dusrpak.dat

Se il modello del package 3D non fosse come
ci si aspettava e lo si volesse cambiare, ¢
necessario eliminare la linea associata al link del
componente errato e salvare il file. Dopo questa
operazione ¢ bene cercare il nuovo package e
creare un nuovo file pov. Come spiegato in
precedenza, se non si dovesse premere il tasto
“Cerca POVRay-macro”, dopo aver scritto il
nome del package 3D e si premesse subito OK,
verrebbe creato un link errato del tipo:

RTRIMTO3XA o,

Questi tipi di link creano errore durante la fase
di dender. Da quanto spiegato si evince che se si
dovessero avere errori dopo la creazione di
nuovi link, € bene dare un'occhiata al file
3dusrpack.dat

In ultimo non vi resta che giocare con le altre
opzioni ¢ ottenere l'immagine che piu si
avvicina alle vostre esigenze.

Bibliografia

www.LaurTec.com : sito di elettronica dove
poter scaricare gli altri articoli menzionati,
aggiornamenti e progetti.

www.cadsoftusa.com : sito inglese dove
scaricare il programma Eagle.

www.cadsoft.de : sito tedesco dove scaricare il
programma Eagle.
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